
Unit 4: Formatting Business Documents: Creating a 
Personal Resume & Cover Letter
Content Area: Technology
Course(s): Sample Course
Time Period: December
Length: Approx 3 weeks, Grades 9-12
Status: Published

Unit 4
Department of Curriculum and Instruction

 

Belleville Public Schools

Curriculum Guide

 

 

 

College Keyboarding
Grades 9-12

 

 

Belleville Board of Education

102 Passaic Avenue

Belleville, NJ 07109

 



 

Prepared by: Teacher, Corey Woodring

 

Dr. Richard Tomko, Ph.D., M.J., Superintendent of Schools

Ms. LucyAnn Demikoff, Director of Curriculum and Instruction K-12

Ms. Nicole Shanklin, Director of Elementary Education K-8, ESL Coordinator K-12

Mr. George Droste, Director of Secondary Education 

 

Board Approved:

 

 

 

Unit Overview
Throughout Formatting Business Documents, Creating a Resume & Cover Letter, students will learn the 
importance and proper format of a resume and cover letter. During this unit, students will be given the 
opportunity to create their own personal resume and cover letter which can be used for acquiring a real job. 

Enduring Understanding
• Common vocabulary associated with the unit.
• Understand the purpose of a resume and cover letter.
• Identify resume format and proper writing used in it.
• Understand the content included in cover letter
• Describe the difference of information in a resume and a cover letter. 

 

Essential Questions
• What is a resume?



• What is a cover letter?
• How a resume is properly formatted?
• How do I to write in resume format?
• What is the purpose of a cover letter?
• What type of information is included inside a cover letter? 

 

 

 

 

Exit Skills
1. Creating, Naming, and Saving a Document

These three basics are the trifecta of getting started with word processing. Make sure to teach students the 
difference between “Save” (which will save your document under the current name) and “Save As” (which 
allows you to rename a document).

2. Formatting (bold, italics, font sizes, aligning text)

The toolbar at the top of your page is your friend when it comes to all things formatting. Let students play 
around with changing font sizes and colors to learn, but then always set clear expectations about the required 
formatting for an assignment.

3. Creating lists (bullet vs. numbered)

With the click of a button from the toolbar, students can create numbered or bulleted lists. Teach students the 
different times when this is appropriate (say for an outline or brainstorming).

4. Line spacing

Also on their main toolbar student have the option of how they want to space their lines. Most academic 
papers use 1.5 or double spaced.

5. Creating columns

Creating columns is especially useful for writing articles, pamphlets, or other specialized pieces. From the 
“Formatting” drop-down menu students can choose two or three columns, or customize their own number.



6. Inserting a bookmark

Just as you use a bookmark to save your place in a book, you can use one in Word to save your place in a 
document. From the “Insert” menu, students can place and name a bookmark so they remember to come back 
to that part later.

7. Inserting an image

If students are writing articles or poetry, they may want to insert an image. Also accessed from the “Insert” 
menu, make sure students have the image they want saved on their computer so that they can upload it.

8. Hyperlinking

This is a great skill to know for informal papers or blog posts where students want to link their own work to 
where they accessed the information. Highlight the text you want to hyperlink, right click and choose 
“hyperlink” and then paste the URL of your destination.

9. Find & Replace

Realize you’ve spelled someone’s name wrong throughout your paper? From the “Edit” menu students can 
find all of the incorrect spellings and ask Word to automatically replace them with the correct spelling. 
Problem solved!

10. Grammar & Spell Check

Most up to date word processing programs will automatically check spelling and grammar for students by 
displaying this squiggly red and green lines. Teach students not to ignore those lines! If they can’t figure out 
the mistake on their own, right click to find the suggested correction.

11. Inserting a page break

Writing a play with multiple acts and want each one to start on a new page? Insert a page break from the 
“Insert” menu to ensure that each act will always start at the top of a new page.

12. Using word count

Minimum and maximum word requirements are a fact of life. From college to the workplace students will 
need to write within a word count range. Use the “Tools” menu to find out how to check your word total so 
far. This number is also displayed as a running total at the bottom of the screen in Microsoft Word.

13. Inserting Tables

Whether writing a biology lab report or a business proposal, you may want to insert a table in your writing. To 
do so click the “Table” button on the toolbar and select how many rows and columns you’re going to need.



14. Inserting Rows/Columns

Need more rows or columns than you initially anticipated? Just right click within your table and choose to add 
a row above or below or a column to the right or left. Repeat as needed!

15. Cell shading

Add visual appeal to your table by shading specific rows or columns to draw attention to headings. Highlight 
the cells you want to shade and from the “Table Design” menu choose shading and the color of your choice.

16. Changing column/row width

While a table will automatically generate with rows and columns of uniform size, there are plenty of instances 
when one needs to customize the layout. The easiest way to do so is by dragging the gridlines between rows 
and columns to suit your needs.

17. Text alignment in tables

When it comes to tables, attention to detail matters. Customize the alignment of text within a cell by right 
clicking in the cell (or highlighting multiple cells and right clicking) to choose how you would like your text to 
be displayed.

18. Changing text direction

Complicated tables or formats may require you to change the direction of your text to better fit the space or 
increase readability. Click within a designated cell and from the “Layout” tab click the text direction button to 
toggle between horizontal and vertical text.

19. Merging cells

For more specialized tables you might want to merge some cells together within certain columns or rows. Just 
highlight the cells in mind and right click to select “Merge”. Voila!

20. Inserting a header

A header is useful in that it appears on every page of your document. This might be your name, a logo, a title, 
or a page number. Whatever you want your header to include, choose “Header” from the “Insert” menu to add 
text. Or, double click at the very top of a page to manually insert your header.

21. Inserting a footer

Same idea as above, just at the bottom of the page. Remember, whatever you write here will show up on every 
page!

22. Footnotes



Common in academic writing, footnotes allow an author to make a note about an idea in the text. Make sure 
your cursor is after the sentence or word you want to make a note about and then click “Footnote” from the 
“Insert” menu to add your comment.

23. Page numbers

Research papers and longer pieces of writing often have page numbers to help the reader reference points in 
the text. From the “Insert” menu choose page number and select where on the page you would like numbers to 
show.

24. Inserting the date

Want to include the date and time on written work? Put your cursor on your document where you’d like the 
date to go and select “Date and Time” from the “Insert” menu.

25. Printing

All done? It’s time to print! Either select the printer icon on the toolbar or click “Print” from the “File” 
dropdown menu. Make sure students pay attention to how many copies they’re printing, if they want double 
sided, and what printer they are printing to.

26. Page orientation

Most written work is done in portrait orientation (meaning your paper goes up and down), but there are plenty 
of times that we would like to have more space from left to right. Select “Page Setup” from the “File” 
dropdown menu and choose “Landscape”.

27. Custom margins

Whether you’re adding a block quote or leaving room for annotations, you might want to change the margins 
for all or part of your text. This can either be done from the “Formatting” tab, or using the ruler at the top of 
your page. Just make sure you’ve highlighted the text you want your new margins to apply to before you get 
started.

 

 

 

 

 

 



New Jersey Student Learning Standards (NJSLS-S)
 

 

 

 

 

TECH.8.1.12 Educational Technology: All students will use digital tools to access, manage, evaluate, and 
synthesize information in order to solve problems individually and collaborate and to 
create and communicate knowledge. 

TECH.8.1.12.A Technology Operations and Concepts: Students demonstrate a sound understanding of 
technology concepts, systems and operations. 

TECH.8.1.12.A.1 Create a personal digital portfolio which reflects personal and academic interests, 
achievements, and career aspirations by using a variety of digital tools and resources. 

TECH.8.1.12.A.CS1 Understand and use technology systems. 

TECH.8.1.12.A.CS2 Select and use applications effectively and productively. 

TECH.8.1.12.B Creativity and Innovation: Students demonstrate creative thinking, construct knowledge 
and develop innovative products and process using technology. 

TECH.8.1.12.B.CS1 Apply existing knowledge to generate new ideas, products, or processes. 

TECH.8.1.12.C.CS1 Interact, collaborate, and publish with peers, experts, or others by employing a variety of 
digital environments and media. 

TECH.8.1.12.C.CS2 Communicate information and ideas to multiple audiences using a variety of media and 
formats. 

TECH.8.1.12.C.CS3 Develop cultural understanding and global awareness by engaging with learners of other 
cultures. 

TECH.8.1.12.C.CS4 Contribute to project teams to produce original works or solve problems. 

Interdisciplinary Connections
 

 

 

LA.RH.6-8.4 Determine the meaning of words and phrases as they are used in a text, including 
vocabulary specific to domains related to history/social studies. 

LA.RH.6-8.5 Describe how a text presents information (e.g., sequentially, comparatively, causally). 

LA.RH.6-8.7 Integrate visual information (e.g., in charts, graphs, photographs, videos, or maps) with 
other information in print and digital texts. 

LA.RST.6-8.2 Determine the central ideas or conclusions of a text; provide an accurate summary of the 
text distinct from prior knowledge or opinions. 



Learning Objectives

 

• Identify the format of a resume and cover letter
• Determine functionality and purpose of using both documents

• Design, Create and Modify a personal resume and cover letter

Suggested Activities & Best Practices
Suggested activities include

Creating / Keying Business documents, Resume APA and MLA Reports

 

 

 

 

 

Assessment Evidence - Checking for Understanding (CFU)
Written Reports-alternate assessment

Teacher Observation Checklist

Unit test-summative assessment

Admit/Exit tickets-formative assessment

Multimeida reports-benchmark assessment

 

 

 



•    Admit Tickets     . 

•    Anticipation Guide     . 

•    Common Benchmarks     . 

•    Compare & Contrast     . 

•    Create a Multimedia Poster     . 

•    DBQ's     . 

•    Define     . 

•    Describe     . 

•    Evaluate     . 

•    Evaluation rubrics     . 

•    Exit Tickets     . 

•    Explaining     . 

•    Fist- to-Five or Thumb-Ometer     . 

•    Illustration     . 

•    Journals     . 

•    KWL Chart     . 

•    Learning Center Activities     . 

•    Multimedia Reports     . 

•    Newspaper Headline     . 

•    Outline     . 

•    Question Stems     . 

•    Quickwrite     . 

•    Quizzes     . 

•    Red Light, Green Light     . 

•    Self- assessments     . 

•    Socratic Seminar     . 

•    Study Guide     . 

•    Surveys     . 

•    Teacher Observation Checklist     . 

•    Think, Pair, Share     . 

•    Think, Write, Pair, Share     . 

•    Top 10 List     . 

•    Unit review/Test prep     . 

•    Unit tests     . 

•    Web-Based Assessments     . 

•    Written Reports     . 

Primary Resources & Materials
 



 

Century 21™ Computer Keyboarding, Lessons 1-80 (Century 21 Keyboarding) 9th Edition

 by Jack P. Hoggatt (Author), Jon A. Shank (Author)

Ancillary Resources

Keyboarding Resources        

Dance Mat Typing--A fun colourful website with animation and games introducing touch typing.

TypingWeb--TypingWeb is a free online typing tutor for typists of all skill levels. TypingWeb's free Teacher 
Portal also allows schools to utilize TypingWeb in the classroom.

Keyboarding Games and Exercises for Kids--A variety of fun activities to enhance keyboarding skills.

Free Typing Games--Premiere site to play free typing games, lessons, and tests. Our Typing Tutor is the best 
way to learn to type. No downloads, installations or registration required. 

Typing Playground--Home to the largest collection of original typing resources on the Internet.

e-Learning for Kids--Keyboard Skills---Become a master Type-E-Chi through a series of engaging and 
entertaining introductory keyboard lessons. 

e-Learning for Kids---Computer Skills---Choose from a variety of computer and keyboarding skills that teach 
lessons and concepts at different levels. (These options are from the same group of resources as mentioned 
above.) 

Learning Games for Kids---Keyboarding Skills---Learning typing is the focus of these keyboarding games. 
Learning keyboarding skills is vital for today’s learners and tomorrow’s earners. These free typing games are a 
great way to build typing skills. Keyboarding games teach important skills through a variety of online typing 
lessons and typing games. And they are fun!

 

.

 

Technology Infusion
Microsoft Word, Google Docs, Online Courseware, Keyboarding Tutorials

https://www.amazon.com/s/ref=dp_byline_sr_book_1?ie=UTF8&field-author=Jack+P.+Hoggatt&text=Jack+P.+Hoggatt&sort=relevancerank&search-alias=books
https://www.amazon.com/s/ref=dp_byline_sr_book_2?ie=UTF8&field-author=Jon+A.+Shank&text=Jon+A.+Shank&sort=relevancerank&search-alias=books
http://www.bbc.co.uk/schools/typing/
http://www.typingweb.com/
http://www.wacona.com/keyboardinggames/keyboardinggames.html
http://www.freetypinggame.net/
http://freeonlinetypinggames.com/
http://e-learningforkids.org/Courses/EN/K0001/index.html
http://www.e-learningforkids.org/computer-skills/
http://www.learninggamesforkids.com/keyboarding_games.html


 

 

 

 



Alignment to 21st Century Skills & Technology

21st Century Skills & Technology and their Alignment to the core content areas is essential to student learning. The core content 
areas include:

• English Language Arts;
• Mathematics;
• Science and Scientific Inquiry (Next Generation);
• Social Studies, including American History, World History, Geography, Government and Civics, and Economics; 
• World languages;
• Technology;
• Visual and Performing Arts.

 

 

LA.RH.6-8.4 Determine the meaning of words and phrases as they are used in a text, including 
vocabulary specific to domains related to history/social studies. 

TECH.8.1.12.E.CS4 Process data and report results. 

TECH.8.1.12.F.CS2 Plan and manage activities to develop a solution or complete a project. 

TECH.8.1.12.F.CS3 Collect and analyze data to identify solutions and/or make informed decisions. 

Craft and Structure 

21st Century Skills/Interdisciplinary Themes
 

21st Century/Interdisciplinary Themes that will be incorporated into this unit.

•    Communication and Collaboration     . 

•    Creativity and Innovation     . 

•    Critical thinking and Problem Solving     . 

•    ICT (Information, Communications and Technology) Literacy     . 

•    Information Literacy     . 

•    Life and Career Skills     . 

•    Media Literacy     . 

9.3.12.ED-ADM Administration & Administration Support 

12.9.3.IT.1 Demonstrate effective professional communication skills and practices that enable 
positive customer relationships. 

12.9.3.IT.2 Use product or service design processes and guidelines to produce a quality information 
technology (IT) product or service. 



21st Century Skills
Upon completion of this section, please remove all remaining descriptions, notes, outlines, examples and/or illustrations that are not 
needed or used.

 

Please list only the 21st Century Skills that will be incorporated into this unit.

 

•    Civic Literacy     . 

•    Environmental Literacy     . 

•    Financial, Economic, Business and Entrepreneurial Literacy     . 

•    Global Awareness     . 

•    Health Literacy     . 

CRP.K-12.CRP1 Act as a responsible and contributing citizen and employee. 

CRP.K-12.CRP1.1 Career-ready individuals understand the obligations and responsibilities of being a 
member of a community, and they demonstrate this understanding every day through 
their interactions with others. They are conscientious of the impacts of their decisions on 
others and the environment around them. They think about the near-term and long-term 
consequences of their actions and seek to act in ways that contribute to the betterment of 
their teams, families, community and workplace. They are reliable and consistent in going 
beyond the minimum expectation and in participating in activities that serve the greater 
good. 

CRP.K-12.CRP2 Apply appropriate academic and technical skills. 

CRP.K-12.CRP2.1 Career-ready individuals readily access and use the knowledge and skills acquired through 
experience and education to be more productive. They make connections between 
abstract concepts with real-world applications, and they make correct insights about when 
it is appropriate to apply the use of an academic skill in a workplace situation. 

Differentiation

• Large print edition

Differentiation in a lesson lies within content, process, and/or product. 

 

 

Differentiations:

• Small group instruction

• Small group assignments

• Extra time to complete assignments

• Pairing oral instruction with visuals

• Repeat directions

• Use manipulatives



• Center-based instruction

• Token economy

• Study guides

• Teacher reads assessments allowed

• Scheduled breaks

• Rephrase written directions

• Multisensory approaches

• Additional time

• Preview vocabulary

• Preview content & concepts

• Story guides

• Behavior management plan

• Highlight text

• Student(s) work with assigned partner

• Visual presentation

• Assistive technology

• Auditory presentations

• Large print edition

• Dictation to scribe

• Small group setting

Hi-Prep Differentiations:

• Alternative formative and summative assessments

• Choice boards

• Games and tournaments

• Group investigations

• Guided Reading

• Independent research and projects

• Interest groups

• Learning contracts

• Leveled rubrics

• Literature circles

• Multiple intelligence options

• Multiple texts

• Personal agendas

• Project-based learning

• Problem-based learning

• Stations/centers

• Think-Tac-Toes

• Tiered activities/assignments

• Tiered products

• Varying organizers for instructions

Lo-Prep Differentiations

• Choice of books or activities

• Cubing activities

• Exploration by interest

• Flexible grouping

• Goal setting with students

• Jigsaw

• Mini workshops to re-teach or extend skills



• Open-ended activities

• Think-Pair-Share

• Reading buddies

• Varied journal prompts

• Varied supplemental materials

 

 

Special Education Learning (IEP's & 504's)

behavior management plan

Special Education Learning adaptations that will be employed in the unit, using the ones identified below.

 

•    printed copy of board work/notes provided     . 

•    additional time for skill mastery     . 

•    assistive technology     . 

•    behavior management plan     . 

•    Center-Based Instruction     . 

•    check work frequently for understanding     . 

•    computer or electronic device utilizes     . 

•    extended time on tests/ quizzes     . 

•    have student repeat directions to check for understanding     . 

•    highlighted text visual presentation     . 

•    modified assignment format     . 

•    modified test content     . 

•    modified test format     . 

•    modified test length     . 

•    multiple test sessions     . 

•    multi-sensory presentation     . 

•    preferential seating     . 

•    preview of content, concepts, and vocabulary     . 

•    Provide modifications as dictated in the student's IEP/504 plan     . 

•    reduced/shortened reading assignments     . 

•    Reduced/shortened written assignments     . 

•    secure attention before giving instruction/directions     . 



•    shortened assignments     . 

•    student working with an assigned partner     . 

•    teacher initiated weekly assignment sheet     . 

•    Use open book, study guides, test prototypes     . 

English Language Learning (ELL)
Using computer word processing spell check and grammar check features

English Language Learning adaptations that will be employed in the unit, using the ones identified below.

 

 

•    teaching key aspects of a topic.  Eliminate nonessential information     . 

•    using videos, illustrations, pictures, and drawings to explain or clarif     . 

•    allowing products (projects, timelines, demonstrations, models, drawings, dioramas, poster boards, 
charts, graphs, slide shows, videos, etc.) to demonstrate student’s learning;

    . 

•    allowing students to correct errors (looking for understanding)     . 

•    allowing the use of note cards or open-book during testing     . 

•    decreasing the amount of workpresented or required     . 

•    having peers take notes or providing a copy of the teacher’s notes     . 

•    modifying tests to reflect selected objectives     . 

•    providing study guides     . 

•    reducing or omitting lengthy outside reading assignments     . 

•    reducing the number of answer choices on a multiple choice test     . 

•    tutoring by peers     . 

•    using computer word processing spell check and grammar check features     . 

•    using true/false, matching, or fill in the blank tests in lieu of essay tests     . 

At Risk
Marking students’ correct and acceptable work, not the mistakes

 

Please identify Intervention Strategies that will be employed in the unit, using the ones identified below.

•    allowing students to correct errors (looking for understanding)     . 

•    teaching key aspects of a topic.  Eliminate nonessential information     . 

•    allowing products (projects, timelines, demonstrations, models, drawings, dioramas, poster boards, 
charts, graphs, slide shows, videos, etc.) to demonstrate student’s learning

    . 

•    allowing students to select from given choices     . 



•    allowing the use of note cards or open-book during testing     . 

•    collaborating (general education teacher and specialist) to modify vocabulary, omit or modify items to 
reflect objectives for the student, eliminate sections of the test, and determine how the grade will be 
determined prior to giving the test.

    . 

•    decreasing the amount of workpresented or required     . 

•    having peers take notes or providing a copy of the teacher’s notes     . 

•    marking students’ correct and acceptable work, not the mistakes     . 

•    modifying tests to reflect selected objectives     . 

•    providing study guides     . 

•    reducing or omitting lengthy outside reading assignments     . 

•    reducing the number of answer choices on a multiple choice test     . 

•    tutoring by peers     . 

•    using authentic assessments with real-life problem-solving     . 

•    using true/false, matching, or fill in the blank tests in lieu of essay tests     . 

•    using videos, illustrations, pictures, and drawings to explain or clarify     . 

Talented and Gifted Learning (T&G)
 Utilize project-based learning for greater depth of knowledge

 

 

 

Talented and Gifted adaptations that will be employed in the unit, using the ones identified below.

•    Above grade level placement option for qualified students     . 

•    Advanced problem-solving     . 

•    Allow students to work at a faster pace     . 

•    Cluster grouping     . 

•    Complete activities aligned with above grade level text using Benchmark results     . 

•    Create a blog or social media page about their unit     . 

•    Create a plan to solve an issue presented in the class or in a text     . 

•    Debate issues with research to support arguments     . 

•    Flexible skill grouping within a class or across grade level for rigor     . 

•    Higher order, critical & creative thinking skills, and discovery     . 

•    Multi-disciplinary unit and/or project     . 

•    Teacher-selected instructional strategies that are focused to provide challenge, engagement, and 
growth opportunities

    . 

•    Utilize exploratory connections to higher-grade concepts     . 

•    Utilize project-based learning for greater depth of knowledge     . 



Sample Lesson
Using the template below, please develop a Sample Lesson for the first unit only.

 

 

Unit Name:

NJSLS:

Interdisciplinary Connection:

Statement of Objective:

Anticipatory Set/Do Now:

Learning Activity:

Student Assessment/CFU's:

Materials:

21st Century Themes and Skills:

Differentiation/Modifications:

Integration of Technology:

 


